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Chapter 1. What is IBM Rational DOORS Web Access?

IBM® Rational® DOORS® Web Access is a member of the IBM® Rational® DOORS
product family, which is a package of requirements management tools that
enterprises can use to effectively manage projects from the concepts phase through
completion.

Rational DOORS Web Access helps promote collaboration and requirements use in
your development process. It provides access to view, discuss, edit, and link
requirements that are managed in your Rational DOORS database using a
zero-footprint web browser application.

What are the licensing options?
You must have either a software or hardware license to run Rational DOORS Web
Access.

Licenses are acquired for each user session, but are managed on the server side
rather than in the client process. The server acquires licenses from the license
server when users connect and releases them when the users log off. Users do not
need direct access to the license server through any firewalls that might exist.

For more information about licensing, see the IBM Rational Lifecycle Solutions
Licensing Guide. The guide is available from the IBM Rational Lifecycle Solutions
DVD, and from the Web site at http://www.ibm.com/software/awdtools/doors/
webaccess/support.

The Rational DOORS Web Access Components
Installing Rational DOORS Web Access involves the installation of a number of
discrete components that are supplied by IBM.

Table 1. Rational DOORS Web Access Components

Component Description

Rational DOORS Web Access
Server

An adaptation of Apache Tomcat. Tomcat is an application
server that executes Java® servlets and renders web pages
that include Java™ Server Pages code.

Rational DOORS Web Access
Broker

An adaptation of Apache ActiveMQ. ActiveMQ is an open
source message broker that implements the Java Message
Service (JMS)

Rational DOORS Database
Server

Stores the data that you will be accessing.

Interoperation Server A Rational DOORS client that you run from the
command-line.

Preparing to install the components
Before you begin your product installation, make sure that the following planning
steps are complete:
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1. Ensure that you meet the system requirements for installing and running
Rational DOORS Web Access. See http://www.ibm.com/software/awdtools/
doors/webaccess/support/ for system requirements.

2. Shut down all other applications.
3. Download the files that you need from the IBM Rational support site at

http://www.ibm.com/software/awdtools/doors/webaccess/support/ to the
appropriate machine. For more information about the components, see “The
Rational DOORS Web Access Components” on page 1.
The following table lists the files that you need to download for each platform:

Platform File Description

Windows® IBM_Rational_DOORS
_Web_Access.exe

Contains:

v Rational DOORS Web Access Server.

v Rational DOORS Web Access Broker.

v IBM JRE for use with Rational DOORS
Web Access. No other external JDK/JRE
is required.

Rational_DOORS_9_2.msi A Rational DOORS client, which acts as
the Interoperation Server for Rational
DOORS Web Access.
Note: The Rational DOORS client is
referenced on the Rational DOORS Web
Access download page but is only
available to download from the Rational
DOORS download area.

Solaris® IBM_Rational_DOORS
_Web_Access.bin

Contains:

v Rational DOORS Web Access Server.

v Rational DOORS Web Access Broker.

v IBM JRE for use with Rational DOORS
Web Access. No other external JDK/JRE
is required.

solaris.zip Contains an Interoperation Server installer
and a Rational DOORS Database Server
installer.

Linux® IBM_Rational_DOORS
_Web_Access.bin

Contains:

v Rational DOORS Web Access Server.

v Rational DOORS Web Access Broker.

v IBM JRE for use with Rational DOORS
Web Access. No other external JDK/JRE
is required.

linux.zip Contains the Interoperation Server
installer.

linux_server.zip Contains a Rational DOORS Database
Server installer.

4. Ensure that you have a valid license for Rational DOORS Web Access. For more
information about licensing and the IBM Rational License Server TL, see the
IBM Rational Lifecycle Solutions Licensing Guide. The guide is available from the
IBM Rational Lifecycle Solutions DVD, and from our Web site at
http://www.ibm.com/software/rational/support/.

5. On Windows, if you are upgrading from a previous version, follow the
instructions that were provided with that version. to shut down the
components before you continue.
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Chapter 2. Installing the components on Windows

To run Rational DOORS Web Access on Windows, you must install the database
server, interoperation server, Web access broker and Web access server.

Installing the Rational DOORS Database Server on Windows
The Web client accesses a Rational DOORS database server. If you have already
installed a database server, you need the port number and the name of the server
machine for use later in the procedure.

About this task

If you do not have a database server installed, you must install one. To install the
database server:
1. Choose the machine you want to run the database server on.
2. Run the Rational DOORS Database Server installer as normal. For information

about installing the database server, see the IBM Rational DOORS Installation
Guide.

3. Install the software. The default port is 36677. Take a note of the port number
you choose and the name of the server for use later in the procedure.

Installing the Interoperation Server on Windows
To install the Interoperation Server.
1. Choose the machine you want to run the Interoperation Server on.
2. Install the Interoperation Server by running the Rational_DOORS_9_2.msi file.

Make sure that you enter the details for the Rational DOORS Database Server
that you want the Web client to access. For more information about installing
the Interoperation Server, follow the instructions for installing a Rational
DOORS Client in the IBM Rational DOORS Installation Guide.

Installing the Rational DOORS Web Access Server and Broker on
Windows

Before you begin

Copy the IBM_Rational_DOORS_Web_Access.exe file to the machine or machines that
you want to install the Web access server and broker on. If you want to install the
server and broker on different machines, repeat the following instructions on each
machine.

To install the Web access server and broker:
1. Choose the machine where you want to install the files.
2. Double-click IBM_Rational_DOORS_Web_Access.exe, and then follow the

instructions to install the files.

Note: You can also run IBM_Rational_DOORS_Web_Access.exe from the
command-line.
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What to do next

Follow the instructions in Chapter 5, “Configuring the required components,” on
page 13.

4 IBM Rational DOORS Web Access: Installing and Configuring DOORS Web Access



Chapter 3. Installing the components on Solaris

To install Rational DOORS Web Access on Solaris operating systems, you must
install the Interoperation Server, database server, Web access broker, and Web
access server. It is possible to install the database server as part of your
Interoperation Server installation.

Installing the Interoperation Server on Solaris
Before you begin

Copy solaris.zip to the machine that you want to run the Interoperation Server
on and log in as root.

To install the Interoperation Server:
1. Create a home directory for the installation.
2. Create a non-privileged user account to own the Interoperation Server files. For

example, you can name the account doors.
3. Navigate to the directory that contains solaris.zip and extract it: unzip

solaris.zip

4. Navigate to the directory that contains the installers: cd unix/bin

5. Run the installers ./instdoor.sh You can use this file to install both the
Interoperation Server and the Rational DOORS Database Server.

Note: If you are installing the Interoperation Server and the database server on
the same machine, you can install them at the same time. At Step 6 b, accept
the installation of the Interoperation Server and the Database Server.

6. Answer the prompts on the screen:
a. Enter path to CD-ROM device or DOORS distribution.
b. Accept the installation of the Interoperation Server.
c. Enter the path to the DOORS home directory that you created in Step 1.
d. Confirm that you do not want to install the interface services.
e. Enter the name of the user that you created in Step 2.
f. Confirm the type of installation. Select both the Common installation and

the Solaris installation.
7. The installation script then confirms all the installation options and installs the

files.
8. When the installation is complete, press ENTER. All updates that are required

for the account profile that you created to own the Interoperation Server files
are displayed in the output.
If you have installed the database server, you can skip the Installing the Rational
DOORS Database Server task.

Installing the Rational DOORS Database Server on Solaris
To run Rational DOORS Web Access on a Solaris system you must install a
Rational DOORS Database Server.
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Before you begin

Copy solaris.zip to the machine you want to run the Rational DOORS Database
Server on and log in as root.

Note: You do not need to perform this task if you installed the database server as
part of your Interoperation Server installation.

About this task

To install the database server:
1. Create a home directory for the installation.
2. Navigate to the directory that contains solaris.zip and extract it: unzip

solaris.zip

3. Navigate to the directory that contains the installers: cd unix/bin

4. Run the installers ./instdoor.sh You use this file to install both the
Interoperation Server and the DOORS Database Server.

5. Answer the prompts on the screen:
a. Enter path to CD-ROM device or Rational DOORS distribution.
b. Decline the installation of the Interoperation Server, then accept the

installation of the database server.
c. Enter the path to the home directory that you created in Step 1.
d. Confirm that you do not want to install the interface services.
e. Enter the name of the owner that you created in Step 2 in the Interoperation

Server installation procedure.
f. Confirm the type of installation. Select the Solaris installation.

6. The installation script then confirms all the installation options and installs the
files.

7. When the installation is complete, press ENTER. Updates that are required for
the account profile that you created to own the Interoperation Server files are
displayed in the output.

Note: If the installation directory for the database server and the Interoperation
Server are different, then the required profile updates will be in conflict. You
can use shell scripts to start the processes instead.

Installing the Rational DOORS Web Access Server and Broker
Before you begin

Copy the IBM_Rational_DOORS_Web_Access.bin file to the machine or machines that
you want to install the Web access server and broker on. If you want to install the
server and broker on different machines, repeat the following instructions on each
machine.

To install the Web access server and broker:
1. Make the IBM_Rational_DOORS_Web_Access.bin file an executable file by

running the following command:
chmod u+x IBM_Rational_DOORS_Web_Access.bin

2. Choose the directory where you want to install the files, and run
IBM_Rational_DOORS_Web_Access.bin. Follow the instructions to install the files.
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3. Set the appropriate permissions on the files in the directory structure and
install the JRE by running the configure-festival.sh script.
a. Navigate to the dwa directory
b. Run the script: bash configure-festival.sh

Note: The script reports that it is installing JRE. The installation is local to the
current directory and does not affect any other Java installations on the system.

What to do next

Follow the instructions in Chapter 5, “Configuring the required components,” on
page 13.

Chapter 3. Installing the components on Solaris 7
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Chapter 4. Installing the components on Linux

To install Rational DOORS Web Access on Linux operating systems, you must
install the Interoperation Server, database server, Web access broker, and Web
access server. It is possible to install the database server as part of your
Interoperation Server installation.

Installing the Interoperation Server on Linux
Before you begin

Copy linux.zip to the machine that you want to run the Interoperation Server on
and log in as root.

To install the Interoperation Server:
1. Create a home directory for the installation.
2. Create a non-privileged user account to own the Interoperation Server files. You

could call this user account doors.
3. Navigate to the directory that contains linux.zip and extract it: unzip

linux.zip

4. Navigate to the directory that contains the installers: cd unix/bin

5. Run the installer ./instdoor.sh

6. Answer the prompts on the screen:
a. Enter path to CD-ROM device or Rational DOORS distribution.
b. Accept the installation of the Interoperation Server.
c. Enter the path to the home directory that you created in Step 1.
d. Confirm that you do not want to install the interface services.
e. Enter the name of the user that you created in Step 2.
f. Confirm the type of installation. Select both the Common installation and

the Linux installation.
7. The installation script then confirms all the installation options and installs the

files.
8. When the installation is complete, press ENTER. All updates that are required

for the account profile that you created to own the Interoperation Server files
are displayed in the output.

Installing the Rational DOORS Database Server on Linux
To run Rational DOORS Web Access on a Linux system you must install a Rational
DOORS Database Server.

Before you begin

Copy linux_server.zip to the machine you want to run the Rational DOORS
Database Server on and log in as root.
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About this task

To install the database server:
1. Create a home directory for the installation.
2. Navigate to the directory that contains linux_server.zip and extract it: unzip

linux_server.zip

3. Navigate to the directory that contains the installers: cd unix/bin

4. Run the installer ./instdoor.sh

5. Answer the prompts on the screen:
a. Enter path to CD-ROM device or Rational DOORS distribution.
b. Accept the installation of the database server.
c. Enter the path to the home directory that you created in Step 1.
d. Confirm that you do not want to install the interface services.
e. Enter the name of the user that you created in Step 2 in the Interoperation

Server installation procedure.
f. Confirm the type of installation. Select the Linux installation.

6. The installation script then confirms all the installation options and installs the
files.

7. When the installation is complete, press ENTER. Updates that are required for
the account profile that you created to own the Interoperation Server files are
displayed in the output.

Note: If the installation directory for the database server and the Interoperation
Server are different, then the required profile updates will be in conflict. You
can use shell scripts to start the processes instead.

Installing the Rational DOORS Web Access Server and Broker
Before you begin

Copy the IBM_Rational_DOORS_Web_Access.bin file to the machine or machines that
you want to install the Web access server and broker on. If you want to install the
server and broker on different machines, repeat the following instructions on each
machine.

To install the Web access server and broker:
1. Make the IBM_Rational_DOORS_Web_Access.bin file an executable file by

running the following command:
chmod u+x IBM_Rational_DOORS_Web_Access.bin

2. Choose the directory where you want to install the files, and run
IBM_Rational_DOORS_Web_Access.bin. Follow the instructions to install the files.

3. Set the appropriate permissions on the files in the directory structure and
install the JRE by running the configure-festival.sh script.
a. Navigate to the dwa directory
b. Run the script: bash configure-festival.sh

Note: The script reports that it is installing JRE. The installation is local to the
current directory and does not affect any other Java installations on the system.

10 IBM Rational DOORS Web Access: Installing and Configuring DOORS Web Access



What to do next

Follow the instructions in Chapter 5, “Configuring the required components,” on
page 13.
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12 IBM Rational DOORS Web Access: Installing and Configuring DOORS Web Access



Chapter 5. Configuring the required components

After you have installed the components for your operating system, you must
configure them to communicate with each other.

Identifying the database Universal Resource Name
The database Universal Resource Name (URN) is used once you start up Rational
DOORS Web Access. You need to locate it now, and make a note of it for later use.
1. If the Rational DOORS Database Server is not already running, then start it.
2. Start the Rational DOORS client and log in to the database.
3. In either the Rational DOORS Explorer or a module window, click Tools > Edit

DXL

4. Type the following DXL script into the DXL input pane:

print getDatabaseIdentifier()

5. Click Run to run the program. A 16 digit hexadecimal number is output, for
example 38f5c98719f27b6d. This forms part of the database URN. In this
example, the database URN is: urn:telelogic:ers-38f5c98719f27b6d:

6. Make a note of the database URN.

Setting up the Rational DOORS Web Access Server
You need to set up the Rational DOORS Web Access Server to communicate with
the broker, the license server and the appropriate Rational DOORS database
repository.

The Rational DOORS Web Access Server is configured using the server\festival
directory. The festival directory contains two subdirectories:
v config

This directory contains festival.xml, the core configuration file within Rational
DOORS Web Access. The festival.xml file:
– Can be configured so that the Rational DOORS Web Access Server

communicates with the broker and the license server
– Contains the URN of the Repository, which must match the URN you

identified in “Identifying the database Universal Resource Name” or the TDS
Repository ID

Note: The config directory contains other files that you must not modify unless
you receive the guidance of IBM Rational support.

v custom
This directory contains a subdirectory containing a file called readme.htm, which
you can use to configure the Welcome screen.

Modifying festival.xml
The festival.xml file is the core configuration file within Rational DOORS Web
Access. You need to modify the entries for f:broker, f:repository-mapping and
f:properties.
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1. In the example, there are three f:broker entries that describe where the broker
is. Edit these entries to point to the url of the machine where you installed the
broker with the default port (61616). If the broker is on the same machine as
the Rational DOORS Web Access Server, you do not have to edit these entries.

2. The f:repository-mapping entry defines the URN of the repository.
a. The name attribute is the name displayed on the Rational DOORS Web

Access log on page. You can change this attribute. The default is DOORS ERS
Repository.

b. The repositoryUrn attribute needs to match the URN of the Rational
DOORS Database Server you identified in “Identifying the database
Universal Resource Name” on page 13. You must change this attribute.

3. The f:properties entry defines the location of the license server. The property
name attribute is licence.server.location with the value 19353@localhost, which
is the port number and machine name of the license server. Edit the value to
point to the location of your license server. This location is added to the list of
license locations held on your system.

Example of festival.xml
The festival.xml file is the core configuration file for Rational DOORS Web Access.
<!--Brokers we know about -->

<f:endpoints>
<f:broker

name="GENERALSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

<f:broker
name="DCSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

<f:broker
name="RMSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

</f:endpoints>

<!-- Mapping from Repository IDs to the broker we use to reach the repository -->
<f:mappings>

<f:repository-mapping
enabled="true"
endpoint="RMSERVICES"
name="DOORS ERS Repository"
repositoryUrn="urn:telelogic:ers-46dd5d7806b96973:" />

</f:mappings>

<!-- Configurable system properties -->
<f:properties>

<f:property name="licence.server.location" value="19353@localhost" />
<f:properties>

</f:lsc>
</f:configuration>
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Setting up the Rational DOORS Database Server
You must configure the Rational DOORS Database Server to communicate with the
broker by adding Data Change Notifications (DCN) parameters to the command
line. DCNs are messages that contain information about changes made to Rational
DOORS data.

To set up the database server:
1. Locate dbadmin.
v On Windows systems, dbadmin is located in the DOORS_9_2\bin directory on

the Rational DOORS client machine
v On Solaris and Linux systems, dbadmin is located in the $DOORSHOME/bin

directory
2. Run dbadmin, in a command line in the following format:

dbadmin -data port@myserver -dcnEnable -dcnBrokerUri
“tcp://myBroker:61616” -dcnChannelName “dcn”

Table 2. Parameters used for the Rational DOORS Database Server command-line setup

Parameter Description

-data port@myserver Identifies the Rational DOORS Database
Server, where port is the port number the
database server is using and myserver is the
name of the machine where the database
server is installed.

-dcnEnable Enables the DCNs

-dcnBrokerUri "tcp://myBroker:61616" Locates the broker, where myBroker is the
machine hosting the broker and 61616 is the
default port that the broker uses.

-dcnChannelName "dcn" Sets up the DCN channel. The channel name
is always dcn.

3. Restart the Rational DOORS Database Server for the new settings to take effect.

Useful DCN commands
Use these commands to check the DCN service status and turn the service off and
on.
v You can use the -dcnInfo parameter to check the DCN service status:

dbadmin -data 36677@myserver -dcnInfo

v You can use -dcnDisable and -dcnEnable turn the DCN service off and on:
dbadmin -data 36677@myserver -dcnDisable
dbadmin -data 36677@myserver -dcnEnable

You need to restart the Rational DOORS Database Server for the new settings to
take effect.
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Chapter 6. Configuring the optional components

You can optionally configure the following components.

Running multiple Interoperation Servers
Setting up your system to run multiple Interoperation Servers can improve
performance and increase the availability of the system.

Performance is improved because more modules can be cached, allowing quicker
access to your data. Rational DOORS Web Access has routing logic to perform
basic load balancing across the Interoperation Servers.

Availability is improved because the system can continue to work if one of the
Interoperation Servers fails. While one Interoperation Server is down, users can
continue to access the database using the others.

To run multiple Interoperation Servers, start up multiple instances of the
Interoperation Server.

All the Interoperation Servers must:
v Connect to the same Rational DOORS Web Access Broker
v Use the same Rational DOORS Database Server

The Interoperation Servers can be on different machines. For information, see step
3 in “Starting the system”.

Understanding the Rational DOORS Redirector Service
The Rational DOORS Redirector Service is an optional service. It allows users to
choose whether to open DOORS URLs in a standard Rational DOORS client or in a
Web client. If the Redirector Service is not configured, DOORS URLs are opened in
a standard client.

The Rational DOORS database, and each project, folder, module, module baseline,
and object in the database has a unique identifier, which is expressed as a URL.
The URL begins doors://. DOORS URLs can be inserted into a web page, stored
as favorites or bookmarks in your browser, included in e-mails, or pasted into
other applications.

If you want Rational DOORS Web Access users to be able to use DOORS URLs in
the same way as Rational DOORS users, configure the Redirector Service and the
Rational DOORS Database Server. Users can then specify whether to open DOORS
URLs in a standard client or in the Web client. The Redirector Service
automatically opens the URL in the chosen tool.

The Redirector Service is installed with the Rational DOORS Web Access Server.
The Redirector Service shares a web server and port with Rational DOORS Web
Access, but is configured separately from Rational DOORS Web Access.
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Configuring the Redirector Service
You have to configure the Rational DOORS Redirector Service, the Rational
DOORS Web Access Server and the Rational DOORS Database Server.
1. Navigate to the directory where you extracted dwa.zip.
2. Open server\festival\config\doorsRedirector.properties in a text editor.
3. Set the doors.url.prefix value to match the database server that is serving

Rational DOORS Web Access in the form doors://host:port/, where host is
the name of the Rational DOORS Database Server machine and port is the port
number it uses (typically 36677).

Important: Do not delete the / at the end of this value.
4. Set the dwa.url.prefix value to match the Rational DOORS Web Access

Server, in the form http://host:port/dwa/, where host is the name of the
Rational DOORS Web Access Server machine, and port is the port number it
uses (typically 8080).

Important: Do not delete the / at the end of this value.
5. Optionally:
v Disable forwarding from the redirector service to Rational DOORS Web

Access by setting <entry key="dwa.enable">false</entry>

v Disable forwarding from the redirector service to Rational DOORS by
setting <entry key="doors.enable">false</entry>

6. Save and close the file.
7. Open server\festival\config\festival.xml in a text editor.
8. Find the line beginning <f:property name="published.url.prefix".
9. Change MYHOSTNAME to the name of the machine where the Redirector Service

is installed.

Important: Do not delete the / at the end of this value.
10. To display URLs in Rational DOORS Web Access, edit the line <f:property

name="display.redirector.urls" value="false"/>. Change value="false" to
value="true", and then save and close the file.

11. Start doorsd then configure the Rational DOORS Database Server so that
generated URLs refer to the Redirector Service. In the bin directory of the
database server installation, run the command:
dbadmin -data port@host -urlPrefix http://yourdwaserver:port/doors/redirector

where yourdwaserver is the name of the Rational DOORS Web Access server
machine, and port is the port number it uses (typically 8080).

12. Restart the Rational DOORS Web Access components.
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Chapter 7. Running Rational DOORS Web Access

When you are ready to use Rational DOORS Web Access, there is a specific order
of procedures to follow for starting, accessing, and stopping the Web client.

Starting the system on Windows
1. Start the broker by running broker.start.bat. This file is in the directory

where you installed the broker.
2. Start the Rational DOORS Database Server as a service on the machine hosting

the database.
3. Run the Interoperation Server on the machine hosting it with its command-line

attributes in the following format:
doors.exe –interop –data port@myserver –brokerHost myBroker –brokerPort brokerport

where:
v port is the port number the Rational DOORS Database Server is using and

myserver is the name of the machine where the Rational DOORS Database
Server is installed

v myBroker is the name of the machine hosting the broker
v brokerport is the port that the broker is using, by default 61616.

4. Start the Rational DOORS Web Access Server by running server.start.bat.
The file is in the directory where you installed the server. It can be slow to start
the first time it is run because it has to unpack some files.

Results

When you run 1, 3 and 4, a command-prompt window opens for each process. Do
not close these windows.

Starting the system on Solaris or Linux
1. Log in as the user that you created when you installed the Interoperation

Server.
2. Start the broker by running broker.start.sh, which is in the dwa directory on

the machine hosting the broker.
3. Set the following environment variables on the machine hosting the Rational

DOORS Database Server.
DOORSHOME=doors-home-path
SERVERDATA=path_to_data_directory
PATH=$DOORSHOME/bin:$PATH
PORTNUMBER=database-server-port-number
export DOORSHOME SERVERDATA PATH PORTNUMBER DOORSDATA

Note: This DOORSHOME variable relates to where the Rational DOORS
Database Server is installed.

4. Start the Rational DOORS Database Server:
a. Log in as the user that you created when you installed the Interoperation

Server.
b. Change your working directory to $DOORSHOME/bin.
c. Enter the following command: ./doorsd &
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5. Set the following environment variables on the machine hosting the
Interoperation Server:
DOORSHOME=doors-home-path
DOORSDATA=36677@myserver
PATH=$DOORSHOME/bin:$PATH
export DOORSHOME PATH DOORSDATA

Note: If the installation directory for the database server and the
Interoperation Server are different, then the required profile updates are
conflicting. This DOORSHOME variable relates to where the Interoperation
Server is installed, and can be different from the DOORSHOME variable used
in step 3.

6. Navigate to $DOORSHOME/bin and run the Interoperation Server with its
command-line attributes in the following format:
./doors9 -interop –data port@myserver –brokerHost
myBroker –brokerPort brokerport &

where:
v port is the port number the Rational DOORS database server is using and

myserver is the name of the machine where the Rational DOORS Database
Server is installed

v myBroker is the name of the machine hosting the broker
v brokerport is the port that the broker is using, by default 61616.

7. Start the Rational DOORS Web Access Server by running server.start.sh,
which is in the dwa directory on the machine hosting the server.

Accessing the Web client
Once you have started the system you can use your Web browser to access data in
your Rational DOORS database.
1. Follow the instructions for starting the system, making sure that the Rational

DOORS Web Access Server has started without error
2. In your browser, enter the URL that points to the Rational DOORS Web Access

Server. For example, http://servername:8080/dwa. The Web client opens and
the Welcome screen is displayed.

3. Enter your User name and Password, and then click Login. You are connected
to the Rational DOORS database.

4. When you are finished, click Logout. The Welcome screen is displayed.

Shutting down the system on Windows
To shut down the system you must stop the following processes.
1. Stop the Rational DOORS Web Access Server by running server.shutdown.bat.

This file is in the directory where you installed the server. The process can take
some time to end (15-30 seconds), and might report a number of socket
warnings while shutting down.

2. Stop the Interoperation Server using the “close window” option in Windows.
3. Stop the Rational DOORS Database Server service using the Windows Control

Panel.
4. Stop the broker by running broker.shutdown.bat. This file is in the directory

where you installed the broker. The process can take some time to end (15-30
seconds), and might report a number of socket warnings while shutting down.
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Shutting down the system on Solaris or Linux
To shut down the system you must stop the following processes.
1. Stop the Rational DOORS Web Access Server by running server.shutdown.sh

script. This script is in the dwa directory. The process can take some time to end
(15-30 seconds), and might report a number of socket warnings while shutting
down.

2. Stop the Interoperation Server by killing the process.
3. Stop the Rational DOORS Database Server using the following command from

$DOORSHOME/bin:
dbadmin -data port@computer -killserver [-password password]

4. Stop the broker by running the broker.shutdown.sh script in the dwa directory.
The process can take some time to end (15-30 seconds), and might report a
number of socket warnings while shutting down.

Uninstalling Rational DOORS Web Access from Windows
Follow these instructions to uninstall Rational DOORS Web Access from your
system.
v Uninstall the Rational DOORS Web Access Server by deleting the dwa directory
v Uninstall the broker by deleting the dwa directory
v Uninstall the Interoperation Server and the Rational DOORS Database Server

using Add/Remove Programs.

Note: Currently, the Interoperation Server program is called IBM Rational DOORS
9.2.

Uninstalling Rational DOORS Web Access from Solaris or Linux
Follow these instructions to uninstall Rational DOORS Web Access from your
system.
v Uninstall the Rational DOORS Web Access Server and broker by deleting the dwa

directory
v Uninstall the Interoperation Server and the Rational DOORS Database Server by

deleting $DOORSHOME
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Chapter 8. Configuring Rational DOORS Web Access

You can configure the Rational DOORS Web Access Server ports, the Rational
DOORS Web Access Broker ports, and HTTPS.

Configuring the Rational DOORS Web Access Server port
You can configure the server by editing the server.xml file in the conf
subdirectory.
1. Open the server.xml file.
2. Navigate to the following line:

<!-- Define a non-SSL HTTP/1.1 Connector on port 8080 -->

3. Change the port number in the line <Connector port=“8080”. This is the port
that the server listens on for HTTP requests. Save the file, and then restart the
server.

Note: Take care when changing the server.xml file, as incorrect edits can lead
to a complete loss of system functionality. Make a backup of the file before you
edit it.

Configuring the Rational DOORS Web Access Broker port
Edit the activemq.xml file in the conf subdirectory of the machine hosting the
broker. Edit the festival.xml file on the machine hosting the Rational DOORS
Web Access Server.

In the activemq.xml file there are entries for <transportConnectors> followed by
multiple <transportConnect.. elements. Each defines a protocol and port that the
broker listens on.

Open activemq.xml and change the URI attribute in the openwire element, which
defaults to port 61616:
<transportConnector name="openwire" uri="tcp://localhost:61616"/>

Save the activemq.xml file.

Finally, on the machine hosting the Rational DOORS Web Access Server, open the
festival.xml file and modify the three broker ports (in bold in the following
example):
<!-- Brokers we know about -->

<f:endpoints>
<f:broker

name="GENERALSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

<f:broker
name="DCSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

<f:broker
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name="RMSERVICES"
url="tcp://127.0.0.1:61616?wireFormat.tcpNoDelayEnabled=true"
username=""
password="" />

</f:endpoints>

Save the festival.xml file, and restart all the components.

Note: Take care when changing the activemq.xml file and the festival.xml file, as
incorrect edits can lead to a complete loss of system functionality. Back up the files
before you edit them.

Configuring HTTPS
Rational DOORS Web Access supports the use of HTTPS communication between
the web browser and the Rational DOORS Web Access Server.

To configure HTTPS you need a certificate. You can make one manually for testing
purposes or you can purchase one from a trusted certificate authority.

You also need to have a keystore containing the server certificate. You can create
and manage a keystore using the standard Java key tool facilities as documented
on the Sun Web site.

You need to define a new connector in the Connector element in the server.xml
file to allow HTTPS. The server.xml file is in the conf subdirectory on the server
machine.

Open the file and make the changes in bold:
<!-- Delete this line from the file
<Connector port="8443“ maxHttpHeaderSize="8192"
maxThreads="150" inSpareThreads="25“
MaxSpareThreads="75“ enableLookups="false"
disableUploadTimeout="true“ acceptCount="100"
scheme="https" secure="true“ clientAuth="false" sslProtocol="TLS"
keystoreFile="c:\dwaServer\keystore.ks"
keystorePass="password" algorithm="IbmX509"
/>
--> Delete this line from the file

By default, this Connector element is commented out. Deleting the line
immediately preceding it and immediately after it makes the element active.

The changes to the file:
v Set the server to use HTTPS on port 8443
v Use the keystore entries to identify the keystore that contains the server

certificate.

Save the file, and then restart the server.

Note: Take care when changing the server.xml file, as incorrect edits can lead to a
complete loss of system functionality. Make a backup of the file before you edit it.

For more information about configuring HTTPS and for other methods of
configuration, see the user documentation for Tomcat.
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Information security
The default deployment of Rational DOORS Web Access uses insecure
communication between each server component.

The system supports the use of HTTPS to protect communications between the
browser and the Rational DOORS Web Access Server. There is currently no support
for secure communication between different server-side components.

You can protect communications using recognized security strategies, such as
firewalls. Users of the Web client typically only need to have direct access to the
Rational DOORS Web Access Server port.
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Chapter 9. Contacting IBM Rational software support

If the self-help resources have not provided a resolution to your problem, you can
contact IBM Rational Software Support for assistance in resolving product issues.

Note: If you are a heritage Telelogic customer, you can go to http://
support.telelogic.com/toolbar and download the IBM Rational Telelogic Software
Support browser toolbar. This toolbar helps simplify the transition to the IBM
Rational Telelogic product online resources. Also, a single reference site for all IBM
Rational Telelogic support resources is located at http://www.ibm.com/software/
rational/support/telelogic/

Prerequisites for contacting IBM Rational Software Support
To submit your problem to IBM Rational Software Support, you must have an
active Passport Advantage® software maintenance agreement. Passport Advantage
is the IBM comprehensive software licensing and software maintenance (product
upgrades and technical support) offering.

You can enroll online in Passport Advantage from http://www.ibm.com/software/
lotus/passportadvantage/howtoenroll.html.
v To learn more about Passport Advantage, visit the Passport Advantage FAQs at

http://www.ibm.com/software/lotus/passportadvantage/
brochures_faqs_quickguides.html.

v For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational Software
Support, you must additionally:
v Be a registered user on the IBM Rational Software Support Web site. For details

about registering, go to http://www.ibm.com/software/support/.
v Be listed as an authorized caller in the service request tool.

Submitting problems
To submit your problem to IBM Rational Software Support:
1. Determine the business impact of your problem. When you report a problem to

IBM, you are asked to supply a severity level. Therefore, you need to
understand and assess the business impact of the problem that you are
reporting. Use the following table to determine the severity level

Table 3. Determining the severity level of your problem

Severity Description

1 The problem has a critical business impact: You are unable to use the program,
resulting in a critical impact on operations. This condition requires an
immediate solution.

2 This problem has a significant business impact: The program is usable, but it is
severely limited.

3 The problem has some business impact: The program is usable, but less
significant features (not critical to operations) are unavailable.
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Table 3. Determining the severity level of your problem (continued)

Severity Description

4 The problem has minimal business impact: The problem causes little impact on
operations or a reasonable circumvention to the problem was implemented.

2. Describe your problem and gather background information, When describing a
problem to IBM, be as specific as possible. Include all relevant background
information so that IBM Rational Software Support specialists can help you
solve the problem efficiently. To save time, know the answers to these
questions:
v What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option applicable
to you:
– Start the IBM Installation Manager and select File > View Installed

Packages. Expand a package group and select a package to see the
package name and version number.

– Start your product, and click Help > About to see the offering name and
version number.

v What is your operating system and version number (including any service
packs or patches)?

v Do you have logs, traces, and messages that are related to the problem
symptoms?

v Can you recreate the problem? If so, what steps do you perform to recreate
the problem?

v Did you make any changes to the system? For example, did you make
changes to the hardware, operating system, networking software, or other
system components?

v Are you currently using a workaround for the problem? If so, be prepared to
describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit your
problem to IBM Rational Software Support in the following ways:
v Online:

Go to the IBM Rational Software Support Web site at https://www.ibm.com/
software/rational/support/ and in the Rational support task navigator, click
Open Service Request. Select the electronic problem reporting tool, and open
a Problem Management Record (PMR), describing the problem accurately in
your own words.
For more information about opening a service request, go to
http://www.ibm.com/software/support/help.html
You can also open an online service request using the IBM Support Assistant.
For more information, go to http://www.ibm.com/software/support/isa/
faq.html.

v By phone:
For the phone number to call in your country or region, go to the IBM
directory of worldwide contacts at http://www.ibm.com/planetwide/ and
click the name of your country or geographic region.

v Through your IBM Representative:
If you cannot access IBM Rational Software Support online or by phone,
contact your IBM Representative. If necessary, your IBM Representative can
open a service request for you. You can find complete contact information for
each country at http://www.ibm.com/planetwide/.
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If the problem you submit is for a software defect or for missing or inaccurate
documentation, IBM Rational Software Support creates an Authorized Program
Analysis Report (APAR). The APAR describes the problem in detail. Whenever
possible, IBM Rational Software Support provides a workaround that you can
implement until the APAR is resolved and a fix is delivered. IBM publishes
resolved APARs on the IBM Rational Software Support Web site daily, so that
other users who experience the same problem can benefit from the same
resolution.

Other information about IBM Rational software
For Rational software product news, events, and other information, visit the IBM
Rational Software Web site.

The website can be accessed at http://www.ibm.com/software/rational/.

Chapter 9. Contacting IBM Rational software support 29

http://www.ibm.com/software/rational/


30 IBM Rational DOORS Web Access: Installing and Configuring DOORS Web Access



Notices

© Copyright IBM Corporation 2010.

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted
by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this
documentation in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply
that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, MA 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Trademarks and service marks

IBM, the IBM logo, and ibm.com, Rational, DOORS, and IBM Rational License
Server TL are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. These and
other IBM trademarked terms are marked on their first occurrence in this
information with the appropriate symbol (® or ™), indicating US registered or
common law trademarks owned by IBM at the time this information was
published. Such trademarks may also be registered or common law trademarks in
other countries. A current list of IBM trademarks is available on the Web at
www.ibm.com/legal/copytrade.html.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.
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Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows and/or other Microsoft products referenced herein are either
trademarks or registered trademarks of Microsoft Corporation.

Solaris is a trademark or registered trademarks of Sun Microsystems, Inc. in the
United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other
countries.
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